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BSD’s goal is to encourage updating at
every turn because the latest information
makes a safer and more accurate specifica-
tion. To do this we strive to make the
updating process as fast and as easy as
possible. This quarter BSD SpecLink
incorporates several enhancements to the
process intended to further simplify
updating and to reduce the time spent
reviewing updates.

As you probably know, the updating
process does not touch user text or user
edits to master text. When you edit a master
paragraph an entirely separate user version
of the text is stored in the project and the
master remains intact. This is what allows
toggling back and forth between master and
project versions of a paragraph. Even the
old master text is not overwritten during the
update process. The new version of a
master paragraph is simply added to the
master database alongside the old. This
allows some projects to continue to use old
master data while others can adopt the new
language.

New features that will help you reduce the
amount of time devoted to reviewing
updated paragraphs include options to
partially update a project. You can now elect
to automatically update reference standards
(citations tagged “RS”) while leaving other
updated paragraphs untouched (see Figure

A). You
can sep-
arately
choose to
update all
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FlexibilityFlexibilityFlexibilityFlexibilityFlexibility
In addition to the new updating features
discussed in another article in this issue,
BSD SpecLink this quarter has two other
significant enhancements that have been
requested by our subscribers. The first new
feature is the ability to easily add and edit
tables. The second new feature is the ability
to change the format of the new 6- and 8-
digit section numbers used in MasterFormat
2004.

Although it has long been possible to insert
a table in a SpecLink section, the process
was a bit complicated and required several
steps. The new Table feature allows our
users to insert a table in a simple, straight-
forward process. From the new Table menu,

tagged manufacturer listings (“ML”), again
leaving other paragraphs untouched. These
new options will greatly reduce the number
of paragraphs that must be reviewed for
possible updating in a typical office master
project, since a significant percentage of the
updates each quarter are devoted to
revising reference standards and the names
or website addresses of building product
manufacturers.

Of course, there are legitimate reasons for
not updating a particular project. However,
any office master project or a project that is
being re-used really should be updated each
quarter, because hundreds of sections
typically have some changes with each new
master database. To aid in the updating
decision, one of the new enhancements to
SpecLink is manifested each time a non-
updated project is opened. A new dialog box
appears, reminding you that the project has
not been completely updated and displaying
the number of paragraphs that would be
affected by the updating process. The
dialog can be easily disabled for a given
project if you so choose.

BSD SpecLink has by far the most up-to-
date master database of any master specifi-
cation system, but to take full advantage of
our comprehensive updating process, you
should be certain to consistently update
those project files that will be used to start
new projects. The update enhancements
that have been delivered this quarter should
make it much easier for our subscribers to
accomplish that goal and to keep their
individual project specifications fully up-to-
date.

See “Enhancements” on page 2

Figure A
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Standing, Left to Right:  Bryant Hendricks, Jeff Baker, Michael White, and Jim Barger.
Sitting, Left to Right: Munira Gokal and Erin Orr.

Meet the BSDMeet the BSDMeet the BSDMeet the BSDMeet the BSD
Sales Sales Sales Sales Sales TTTTTeam…eam…eam…eam…eam…

Under the direction of Bryant Hendricks,
Director of Sales & Marketing, BSD
continues to expand its sales team as a
result of significant growth over the past
year.  Each one of our Product Consultants
is familiar with the entire suite of BSD
SoftLink products and is highly trained to
provide our customers and prospects with
the outstanding customer service they have
come to expect. They are also well versed in
relevant marketplace topics such as LEED
certification and the new MasterFormat
2004. As consultants, they are eager to
provide you with timely and informative
answers to all your questions about our
products and services and to offer you a
FREE web demonstration at your
convenience.

click on Insert Table, enter the required number of
columns and the required number of rows in the
resulting dialog box, and then click OK (see Figure 1).
The table is inserted at the current cursor location
and paragraph hierarchy level, pushing the original
paragraph down. The initial column width is deter-
mined automatically—dividing the space available by
the number of columns required. Once the table has
been created, it is possible to make a number of
adjustments from the Table menu. You can insert a
new row into the table below the current row, change
the width and alignment of each column, add or
remove a printing border, or delete the current row or column. Tables must be created in
SpecLink, because there is currently no way to import a table from word processing.

There is also a new setting on the Summary Info dialog box that allows users to change the
formatting of the new MasterFormat 2004 section numbers. The original format established
in SpecLink separates the first pair of numbers (the division number) from the remaining
four, so the section ID numbers appear as XX XXXX. Now it is possible to change the
section number formatting to XX XX XX or to XXXXXX (see Figure 2). In addition, if a
format is chosen that includes spaces between the number pairs, you can substitute a
separator in place of the spaces. For example, if you choose a hyphen separator, the section
numbers will appear as XX-XXXX or XX-XX-XX. The section number format can be

changed at any time and is stored as a project setting.

As mentioned above, these new features are designed to
add flexibility to SpecLink and have been requested by
many of our subscribers. We think our users will find
them useful, both now and in the future. Please let us
know if you like them.Figure 2

“Enhancements” continued from page 1 CostLink/AECostLink/AECostLink/AECostLink/AECostLink/AE
Gets New Cost DGets New Cost DGets New Cost DGets New Cost DGets New Cost Daaaaatttttaaaaa

The Spring 2005 version of CostLink/AE
includes the 2005 RS Means database.  The
new database will be installed automatically
alongside your previous database when you
install the new version of the software.

The 2005 RS Means database includes a
new Building Cost Model for an Assisted
Senior Living Facility. This cost model
includes the six most common framing and
exterior wall system alternatives.  The 2005
database also includes 41 new assemblies
and 583 new line items, as well as updated
location adjustment factors.  The new line
items add unit price data for mold abate-
ment, demolition and removal, and roof
curbs for mounting of A/C and ventilation
equipment.  Price changes have been made
by RS Means for lumber, steel, asphalt,
insulation, PVC, trade labor costs and other
building products.

If you use BSD’s templates to create a new
project, your new projects will automatically
use the 2005 RS Means database.  Any
projects you have previously created and

See “New Cost Data” on page 7

Figure 1
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BSD Customer CBSD Customer CBSD Customer CBSD Customer CBSD Customer Case Studyase Studyase Studyase Studyase Study:::::
BCArchitects CreaBCArchitects CreaBCArchitects CreaBCArchitects CreaBCArchitects Create Clear and Concisete Clear and Concisete Clear and Concisete Clear and Concisete Clear and Concise

SpecificaSpecificaSpecificaSpecificaSpecifications tions tions tions tions WWWWWith SpecLinkith SpecLinkith SpecLinkith SpecLinkith SpecLink
BCArchitects AIA, Inc., located in Coral Gables, has created some of
South Florida’s most distinctive architectural designs, and is

annually responsible for
providing services for projects
with construction values in
excess of 300 million dollars.

Their award-winning portfolio
includes luxury residential,
retail and facilities design for
some of the region’s most
respected developers and
corporations. The full service
architecture and planning firm
provides a single source for
clients seeking innovative
solutions that are elegant,
efficient and cost effective.

Design of the highest quality,
together with outstanding
professional service, have

been the hallmarks of BCArchitects since its inception nearly a
decade ago. Their ability to listen to their clients and respond
creatively has earned their respect. Their clients benefit from

BCArchitects’ multidisciplinary expertise in design, production and
construction. They have the flexibility to work successfully within
the framework of a strong development, or serve as the lead team –
all depending on their client’s needs.

Their 23-person staff is closely committed as a team. They don’t just
deliver a product; they  operate on the principle that their clients
buy into a relationship with BCArchitects – a relationship where
they work as partners for the long term. They listen to the client,
cater to their needs, and do not try to impose their desires onto
them. Many clients are repeat, constantly providing referrals and
recommendations that continue to grow their business.

The need: A consistent goal of BCArchitects is to provide outstand-
ing service, while working in partnership with their clients. In 1998,
they were outsourcing their specifications, and determined that the
outsourcing process didn’t completely fit with this objective. Larry
Cohan, president and CEO at BCArchitects, knew there had to be a
more efficient way for them to produce specifications. Explains
Cohan, “We were using an outsource consultant for our specs who
was not always available for meetings and therefore not always in
the direct communication line. Making changes and updates was a
hassle and took too much time.” He decided to look at SpecLink.

One City Plaza, West Palm Beach

PerSpective Performance SpecsPerSpective Performance SpecsPerSpective Performance SpecsPerSpective Performance SpecsPerSpective Performance Specs
StStStStStaaaaatistics:tistics:tistics:tistics:tistics:

• 161 sections, 17 updated (11%)
• 17,368 paragraphs
• 21,616 internal links (targets and

consequences)
• 3,285 notes to specifier
• 183 external documents referenced, 53%

verified as unchanged or reapproved
• 3 documents never before referenced
• 17 obsolete documents replaced or

removed
• 38 standards organizations referenced

SpecLink+ StSpecLink+ StSpecLink+ StSpecLink+ StSpecLink+ Staaaaatistics:tistics:tistics:tistics:tistics:
• 675 sections total, 274 updated or new

(40%)
• 5 new non-proprietary sections, 2 with

checklists
• 503 non-proprietary sections, 252

updated or new (50%)
• 172 proprietary sections, 22 updated

(13%)
• 20 sections with built-in checklists
• 110,190 paragraphs
• 116,137 internal links (targets and

consequences)
• 18,359 notes to specifier
• 3,271 notes with live hyperlinks to

Internet web pages
• 2,098 external documents referenced,

43% verified as unchanged or
reapproved

• 5 documents never before referenced
• 111 obsolete documents replaced or

removed
• 184 standards organizations referenced
• 2 new standards organizations
• 2,253 manufacturer listings, with live

hyperlinks to their webs sites
• 902 unique manufacturers listed in 353

non-proprietary sections

About Your SpecLink & PerSpective Updates

Short FShort FShort FShort FShort Form Specs Storm Specs Storm Specs Storm Specs Storm Specs Staaaaatistics:tistics:tistics:tistics:tistics:

• 16 sections corresponding to
MasterFormat 1995 divisions

• 8,298 paragraphs
• 814 notes to specifier
• 8,786 internal links (targets and

consequences)

• 365 external documents referenced, 32%
verified as unchanged

• 13 obsolete documents replaced or
removed

• 44 standards organizations referenced

See “BCArchitects” on page 7
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New Non-ProprietNew Non-ProprietNew Non-ProprietNew Non-ProprietNew Non-Proprietary Sectionsary Sectionsary Sectionsary Sectionsary Sections

01 7900 ( ( ( ( (01820) BSD - Demonstra) BSD - Demonstra) BSD - Demonstra) BSD - Demonstra) BSD - Demonstration andtion andtion andtion andtion and
TTTTTraining:raining:raining:raining:raining:

This section describes requirements that apply to all types of
demonstration and training.  Although it primarily applies to
operating equipment and systems, it actually applies to anything the
Owner wishes to have demonstrated or personnel formally trained
on.  For example, there is a lot of  “architectural” equipment for
which training would improve the facility’s operational efficiency.  In
addition, such items as roofing have specific maintenance and repair
requirements.  This section is more detailed than the article “Demon-
stration and Instruction” in Section 01 7000 (01700) - Execution
Requirements.  Use one or the other, not both.

For commissioning purposes, the scope of training is usually the
only thing that distinguishes projects on which commissioning is
required from those that don’t.  Edit the list of training to be
accomplished.  This section contains references to submittals that
go to the Commissioning Authority; if full commissioning is not
required all submittals should be submitted the same as shop
drawings, samples, etc.

01 9113 BSD - General Commissioning BSD - General Commissioning BSD - General Commissioning BSD - General Commissioning BSD - General Commissioning
Requirements (Requirements (Requirements (Requirements (Requirements (01810 BSD - Commissioning):BSD - Commissioning):BSD - Commissioning):BSD - Commissioning):BSD - Commissioning):

This section covers commissioning scope (which systems and
products to commission), overall objectives, procedures that apply
to commissioning any type of product or system, and the
Contractor’s responsibilities.  This section should be used if an
independent Commissioning Authority is engaged by either the
Owner or the Construction Manager (as owner’s agent) for any
commissioning work.

Some of the responsibilities of the Commissioning Authority are
defined in this section, so that the Contractor knows what they are.
Other duties, especially design phase activities, can be defined
using Section 01 9114 (01815) - Commissioning Authority Responsi-
bilities.  That section does not need to be included in the contract
documents but including it for the Contractor’s information will not
be detrimental.

01 9114 ( ( ( ( (01815) BSD - Commissioning ) BSD - Commissioning ) BSD - Commissioning ) BSD - Commissioning ) BSD - Commissioning AAAAAuthorityuthorityuthorityuthorityuthority
Responsibilities:Responsibilities:Responsibilities:Responsibilities:Responsibilities:

This section describes the duties of an independent Commissioning
Authority.  This section is not normally part of the construction
Contract Documents because the Commissioning Authority it
describes is not a party to the construction contract.  This section is
not intended to be included in the Contract Documents, although
inclusion for the information of the Contractor would not be
detrimental.

That section can be used to scope a Request for Proposal for a
Commissioning Authority contract. The Commissioning Authority
reports directly to the Owner, or if a Construction Manager as

owner-agent is involved, directly to the Construction Manager.  The
Commissioning Authority can be involved throughout the design
phase or only for the construction phase.  This section covers the
commissioning activities required for LEED New Construction
Certification, including construction phase commissioning, produc-
tion of a Recommissioning Manual, and post-occupancy reviews.
Design phase reviews need to be added by the user based on the
requirements of the project.

12 2116 ( ( ( ( (12491) BSD - ) BSD - ) BSD - ) BSD - ) BSD - VVVVVertical Louver Blinds:ertical Louver Blinds:ertical Louver Blinds:ertical Louver Blinds:ertical Louver Blinds:

This section includes vertical blinds with PVC, fabric, fabric insert,
and aluminum vanes, and optional motor operators.  The vertical
louver blinds specified in this section are contract quality and better,
intended for installation under the construction contract or under a
tenant-fitup contract.  If the least expensive, residential quality is
desired, include as little detail as possible and don’t list manufactur-
ers.

23 0800 ( ( ( ( (15012) BSD - Commissioning of HV) BSD - Commissioning of HV) BSD - Commissioning of HV) BSD - Commissioning of HV) BSD - Commissioning of HVAAAAAC:C:C:C:C:

This section describes specifics of commissioning as it relates to
HVAC and primarily to the HVAC system and control system as a
whole.  Certain other commissioning requirements are specified in
other sections, notably Sequence of Operation, in 23 0993 (15940),
and Testing, Adjusting, and Balancing, in Section 23 0593 (15950).
This section must be used with Section 01 9113 - General Commis-
sioning Requirements (01810 - Commissioning), which defines
responsibilities, among other things.

In regards to submittals, there is some overlap between this section
and other sections where the controls system, TAB, and sequences
of operation are specified.  In those sections, shop drawings and
other submittals describe some of the same things that the commis-
sioning documentation does.  In theory, the two sets of submittals
would show the same thing but in practice the commissioning
documentation is required to be more detailed.  In some cases, the
submittals of this section could be built upon the standard shop
drawings, extending and amplifying them.  On the other hand, the
overall HVAC system documentation needed for a commissioning
plan and, especially, a re-commissioning plan is not specified
anywhere else than in this section.

Under the provisions of Section 01 9113 (01810), both the
Prefunctional Checklists and the Functional Test procedures are
prepared by the independent Commissioning Authority after award
of the contract.  To some extent, the Contractor may not know
exactly what must be done.  The more completely the scope and
extent of Functional Testing can be defined in the contract docu-
ments, the less likely change orders may be necessary.  Functional
Testing of the HVAC control system is defined in this section.  Other
Functional Tests should be defined in the section where the
equipment is specified.  Samples of Prefunctional Checklists and
Functional Test procedures can be found at www.peci.org/library/
mcpgs.htm.
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Commissioning SpecificaCommissioning SpecificaCommissioning SpecificaCommissioning SpecificaCommissioning Specifications in BSD SpecLinktions in BSD SpecLinktions in BSD SpecLinktions in BSD SpecLinktions in BSD SpecLink®®®®®

New for the Spring 2005 quarter are the following four building commissioning specifications:

01 9113 - General Commissioning Requirements * 01810 - Commissioning *

01 9114 - Commissioning Authority Responsibilities * 01815 - Commissioning Authority Responsibilities *

23 0800 - Commissioning of HVAC 15012 - Commissioning of HVAC

01 7900 - Demonstration and Training 01820 - Demonstration and Training

Specifying Commissioning Using SpecLinkSpecifying Commissioning Using SpecLinkSpecifying Commissioning Using SpecLinkSpecifying Commissioning Using SpecLinkSpecifying Commissioning Using SpecLink

Existing sections that apply to the commissioning process:

• 01 3000 (01300) - Administrative Requirements:  Extra copy of
submittals for Commissioning Authority and reference to
General Commissioning Requirements for more detail.

• 01 3531 (01115) - LEED Requirements:  Explicit reference to the
new commissioning sections.

• 01 5721 (01734) - Indoor Air Quality Controls:  Precautions and
procedures to be executed by the Contractor, with the
Commissioning Authority spot checking.

See “Specifying Commissioning” on page 7
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• 01 7800 (01780) - Closeout Submittals:  General requirements for
O&M manuals.

• 23 0593 (15950) - Testing, Adjusting and Balancing for HVAC:
Spot checking TAB by Commissioning Authority.

• 23 0993 (15940) - Sequence of Operations for HVAC:  Detailed
sequence of operations submittal for the use of the
Commissioning Authority in preparing Plan and Functional Test
procedures.

SpecLink commissioning provisions are based on the assumption
that an independent Commissioning Authority will be engaged to
prepare the Commissioning Plan, Commissioning Schedule, and the
Training Plan; conduct reviews of the O&M data; prepare and
approve Prefunctional Checklists; and prepare Functional Test
procedures and witness Functional Tests.  The Contractor is
responsible for startup reports, filling out and submitting the

Prefunctional Checklists, and
performing Functional Tests
on each item to be commis-
sioned.  Utilizing this proce-
dure would achieve the
commissioning prerequisite
and credit for LEED Certifica-
tion.

Prefunctional Checklists are
detailed forms that the
Contractor must fill out,
verifying that the work is
installed in accordance with
the Contract Documents and
the manufacturer’s recommen-
dations and instructions and
that it receives adequate
operational checkout prior to
startup.  These are usually
more detailed than manufac-
turers’ typical startup check-
lists because they include
prerequisites and related

issues that the manufacturers are usually not concerned with.

Functional Tests are live tests on the fully checked out, started up,
and operational systems and equipment, to verify and document
that functional performance is in accordance with the Contract
Documents. The Commissioning Authority prepares step-by-step
test procedures for the Contractor and forms to document the tests,
for the Commissioning Authority’s own use.

The responsibilities defined in these sections are based on the
Model Commissioning Specifications of Portland Energy Conserva-
tion, Inc. (PECI), which were developed with support from the U.S.
Department of Energy.  The Model Specifications can be found at
www.peci.org/library/mcpgs.htm.  Much of the content of the Model
Specifications is included in the new and existing SpecLink sections
listed above, although the organization has been modified to fit the
existing SpecLink section organization.  One particular exception,
though, is that we did not add the sample Prefunctional Checklists
or Functional Test procedures to SpecLink, but instead have
referenced the PECI website for the Contractor’s information.

These sections allow for the probability that the Commissioning
Plan, Prefunctional Checklists, and Functional Test procedures are
not complete at the time of award of the construction contract.  The
main reason for this is that the preparation requires a considerable
amount of work, customized to the particular building systems that
are specified.  In addition, a certain amount of that customization
must wait until the actual equipment to be installed has been
identified.  To compensate for lack of information at bid time, the
specifications call for a detailed list of all Checklists and Test
procedures to be included in the specification and references
samples for more information.  Despite this, the Contractor may still
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All ProductsAll ProductsAll ProductsAll ProductsAll Products

How can I tell the file name and
location of the project I have open?

From the File menu, choose Summary
Info. The file name and location are

listed at the top of the Summary Info dialog
box.

I want to move the software from one
computer to another, but the access

key won’t work. Why is that?

The access key you received when
you installed the software is specific

to the computer on which it was installed. To
move the software to another computer, call
Tech Support at 800-266-7732 for an
Unpermit code before you remove the
software from the first computer. Before you
call, you can have the software already
installed on the new computer, and then
after we get the Unpermit code, we can
generate a new key for the new computer.

I copied a project to my hard drive
from a CD, but I’m getting an error

when I try to open it. What does it mean?

Unless you are using Windows XP,
files that are copied from a CD-ROM

to your hard drive are copied with a read-
only attribute. In Windows Explorer, right-
click on the file you are trying to open, and
choose Properties. Deselect the Read Only
attribute and click OK. You should be able to
open the project now. If you have Windows
XP, the operating system will automatically
do this for you when you copy the file to
your hard drive.

SpecLink+ and PerSpectiveSpecLink+ and PerSpectiveSpecLink+ and PerSpectiveSpecLink+ and PerSpectiveSpecLink+ and PerSpective

I would like to contact other users of
the software to see how they handle

certain issues. Is there any way I can do
that?

We now have a user forum on our
website. Go to our website at

www.bsdsoftlink.com and click on On-Line
User Forums to sign up. This bulletin board
contains private forums for the use of
subscribers only.

I saw an email about SpecLink
consulting. What was that about?

We are maintaining a list of SpecLink
users who are interested in doing

specs for other SpecLink firms. Those in need
of spec consultants will prepare an ad
outlining their needs and we will forward that
ad to the users who have asked to be put on
the list. The people who receive the ad via
email will then reply directly to the firm
placing the ad.

In SpecLink, how do I find a section
on a particular product?

There is a catalog listing of all the
sections available in PDF format on

the quarterly CD browser. The catalog
listings are also on our website at
www.bsdsoftlink.com/speclink/catalogs/
all_catalogs.htm. You can get the listings in
either MasterFormat 1995 or MasterFormat
2004.

In PerSpective, how can I get an
overview of the structure and

understand what each section is for?

There is a catalog listing of all the
chapters available in PDF format on

the quarterly CD browser. The catalog listing
is also on our website at
www.bsdsoftlink.com/speclink/catalogs/
all_catalogs.htm.

CostLink/AECostLink/AECostLink/AECostLink/AECostLink/AE

What will happen to costs in my
CostLink/AE estimates when I install

the Spring update?

 Nothing will happen to your costs
unless you select to update them to

the new RS Means costs. The 2005 RS
Means database will be installed when you
install the update. Any new projects you
create from the CostLink/AE templates will
use the new costs. When you open or copy
existing projects, they will still be using the

older costs. You can choose the option
Change RS Means Database from the Tools
menu. You will be presented with different
options about which costs you would like to
change. See the CostLink/AE Release Notes
or Chapter 7 of the CostLink/AE User
Manual for details.

 How can I change the costs in an
estimate I created using one of the

RS Means models?

To insert a different assembly in a
CostLink/AE project, click on the

assembly icon in the toolbar. The assemblies
are in UniFormat WBS. You can use the Find
icon to search the database for the assembly
you need, or you can navigate in the Tree to
find the cost data you need. If there is no
assembly for the costs are you looking for,
click on the Book icon to open the RS
Means line items. Once you find the cost
item(s) you need, copy them into your
project and assign a quantity. The copied
items will not be linked to your model. If you
cannot find what you need in the RS Means
databases, you can choose Insert Task from
the Inset menu to add your own item.

CostLink/CMCostLink/CMCostLink/CMCostLink/CMCostLink/CM

How can I change the order of line
items in my estimate?

By default, line items are sorted by
the source tag. If you would like

your line items in a different order both on-
screen and in your detail reports, turn on the
sequence column. From the Tools menu,
choose User Options. In the User Options
dialog box under Select Project Panel,
choose Project Sheet. The right side of the
dialog box will update to show a list of
available column types. In the Include
column, click to place a checkmark in the
checkbox for Seq (Numeric user-defined sort
order). Click the Close button. The Seq
column is now displayed in the Sheet Panel.
Type numbers in the Seq column. Click on a
different title and back on this one - the
tasks are sorted by the sequence column.
When the sequence column is on, the tasks
are first sorted by the Seq column and then
by the Source Tag column.
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“Specifying Commissioning” continued from page 5

“New Cost Data” continued from page 2

The solution: “With SpecLink, our specifications are now prepared
in house by two of our project architects and myself,” says Cohan.
“And changes to the specs can now be easily made by our adminis-
trative staff. Having our project architects prepare the specs has
created better checked and coordinated drawings along with saving
us money by bringing the process in-house. As a matter of fact,
SpecLink paid for itself after the first project or two compared to
what we were paying for outsourcing. Also, being able to have our
administrative staff make the necessary changes and updates has
saved time and money on the preparation of the specification
manuals.” Cohan estimates that compared to the time it took to work
with the outsource consultants to write the specs, they have
reduced their spec writing time by at least 40 percent with SpecLink.

And the time savings came quickly. While some firms think that
bringing spec writing in-house is too tedious and time consuming,
Cohan says that with SpecLink they were able to learn the software
immediately with no formal training.

The outcome: When asked what helped him decide to make the
switch to SpecLink, Cohan comments, “Along with the benefits
listed above with bringing SpecLink in-house, the ability to have a

correct template format, combined with a subscription that updates
reference standards and products on a regular basis.” The quarterly
updates have been a great time-saving tool as well. Because the
updates occur in a controlled environment, their administrative staff,
who are not necessarily familiar with standards, are able to assist
with the specification updates.

And it’s not just the program and updates that have impressed
Cohan. He talks about his high regard for the technical support he
receives as well. “The SpecLink technical support is excellent. One
particular person in BSD’s support department has been there as
long as I can remember and has helped me through numerous install
issues, even when I cause them, along with various upgrade and
technical questions.”

BCArchitects used SpecLink to create the specifications for One
City Plaza in West Palm Beach (the project pictured on the front).
Cohan states, “The specifications for this project needed to be
extremely clear and concise, so that the general contractor and his
subs clearly understood their tasks and the standards of quality
required by the Owner. With no room for error, SpecLink helped us
produce a set of specifications that accomplished this.”

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

More questions?
Contact BSD Technical Support:

Toll Free: 800-266-7732
In Atlanta: 404-365-9226

Email: support@bsdsoftlink.com
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○

○

not know exactly what must be done.  The more completely the
scope and extent of Functional Testing can be defined in the
contract documents, the less likely change orders may be necessary.
Functional Testing can be added to any section where it would be
applicable.

Specifying Commissioning:

Step 1 - Edit the General Requirements:  Two non-printing checklists
are included ( * ) to aid in establishing the proper contractual
relationships, submittal procedures and timing.  Read 01 9113
(01810) General Commissioning Requirements and 01 9114 (01815)
Commissioning Authority Responsibilities.  The Master Text Copy
of these will include the non-printing checklists.  Then execute the
checklists and review the result.

Step 2 - Specify the Scope:  The scope of the work to be commis-
sioned must be defined, either by using the list in Section 01 9113
(01810), or by mentioning commissioning in every section that
applies.

Step 3 - Provide Enough Detail on Functional Testing:  Testing the
HVAC control system is defined in Section 23 0800 (15012).  Other
Functional Tests should be defined in the section where the
equipment is specified.  PECI’s Model specifications (see below)
include some samples.  If it’s too hard to define Functional Test
procedures prior to issuing bidding documents, Section 01 9113
(01810) includes two alternatives that give the Contractor some idea
of the degree of detail anticipated:  1) a list of the Test procedures to
be developed, and 2) reference to the PECI sample test procedures
on the web.

any copies you make of those projects will continue to use the 2004
RS Means database unless you elect to change the project to the
2005 RS Means database.

To determine which database your project is using, open the project
and click on File | Summary Info.  The RS Means database section
will display the name of the currently referenced database.  Using
the Change RS Means Database command from the Tools menu you
can change to the 2005 RS Means database for the addition of
future cost items and leave the existing cost items with the 2004
pricing.  You also have the option to update all existing costs to the
2005 RS Means database.

As with previous versions, CostLink/AE users have the ability to
substitute assemblies that are provided in the cost models by
clicking on the Assemblies icon and finding the assembly they need.
The 20,000 lines items are available by clicking on the Book icon,
and user defined cost items may be added to the estimate at any
time.

“BCArchitects” continued from page 3
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BSD SpecLink+
Either Day*  $495
Both Days*  $895

March 8-9
April 12-13

June 1-2
July 12-13
Sep 13-14
Oct 18-19

AIA Members: Submit Course Completion
Certificate for 7 or 14 Continuing Education

Units
CSI Members: Submit Course Completion

Certificate for 7 or 14 Education Contact
Hours (ECHs) toward your CCS, CCCA, or

CCPR Certification renewal

* Class starts at 9:00 AM and ends at 5 PM.

BSD CostLink/CM
3 days*  $1295

March 1-3
June 7-9

September 20-22
December 13-15

AIA Members: Submit Course Completion
Certificate for 24 Continuing Education Units
CSI Members: Submit Course Completion
Certificate for 24 Education Contact Hours
(ECHs) toward your CCS, CCCA, or CCPR

Certification renewal

* Class starts at 9:00 AM and ends at 5 PM.

The BSD SpecLink+
Workshop

The BSD SpecLink+ Workshop consists of
two one-day workshops.  The first day is
devoted to learning the basics of
SpecLink+, including how to navigate
within the software, start a new project, edit
sections, understand how the links and
choices work, and how to format, print and
export the final document.  It is designed
for new users.  The second day is designed
for those who want to learn how to create
and maintain their own office master.  This
day covers the concepts of an office mas-
ter, how to customize your master by add-
ing choices, links, and tags, as well as cre-
ating your own checklists.  Users must al-
ready be familiar with the basics of
SpecLink+ to attend the second day.

View BSD class schedules on our website! Go to www.bsdsoftlink.com and click the Training link. Get directions & information on travel, hotels, & Atlanta!




